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1 Welcome to Deep Log Analyzer

Thank you for choosing Deep Log Analyzer. Deep Log Analyzer is the premier application to use for analyzing
your website visitors behaviour and website. Choose one of the topics below or use Contents, Index, or Search
tab on the left side to get help. This help describes both Standard and Professional editions. Some features are
only available in Professional edition of Deep Log Analyzer.

· System Requirements
· Installing Deep Log Analyzer

You can download an evaluation copy of Deep Log Analyzer or from our website. Go to www.deep-
software.com and follow the directions for downloading a copy of the software. It's quick and easy!

· Starting Deep Log Analyzer
· Exploring the Interface
· For Quick Start read: Creating a New Project
· Reports Overview
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2 Audience

We assume you are an experienced computer user with appropriate education and training. We assume you
know how to search your computer for files and use menus and other standard window items, such as drop-
down menus. You should be familiar with standard computer and Internet terminology.
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3 Contacting Customer Support

If you require additional assistance using our products, or have any comments, feel free to contact us. Our
Online Support Center address is: http://www.deep-software.com/support.aspx

Tip:  Deep Software provides www.deep-software.com website as a starting point for all customer
support.

If you have a technical question or problem, be sure to provide us with as much information as possible when
emailing our support staff so that we can get back to you with a solution. Your email should include as much of
the following information that you can provide:

· Contact information, i.e., name, telephone number, and email address
· Order reference number (for registered users)
· Deep Log Analyzer version
· Operating System
· Log file format
· Detailed description of the problem, including the steps to reproduce it
· Complete error message text if any
· Screenshots if it helps to explain the problem

If you have a problem relating to a specific log file, feel free to attach your log file(s).

http://www.deep-software.com/support.aspx
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4 System Requirements

This topic lists the hardware and software needed to run Deep Log Analyzer.

The minimum system requirements needed to run Deep Log Analyzer are:
· Operating System: Windows 2000/XP/Server2003/Vista
· CPU: Pentium class - 1 GHz
· RAM: 128 MB
· Hard Drive space: 25 MB plus space for databases and logs
· Internet Explorer 5.5

Note:  The minimum requirements will run DLA, but may not provide the best system performance.

The following specifications are recommended for DLA's best performance:
· Operating System: Windows XP/2003/Vista
· CPU: Pentium 4 - 2GHz
· RAM: 512 MB
· Hard Drive space: 1 Gb
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5 Installing

Deep Log Analyzer is a client side log analyzer program. There is no need to install it on a web server
computer. It can access web server log files through LAN or FTP server. This way Deep Log Analyzer will not
create any additional workload on the web server that can remain dedicated to serve clients requests.

Administrator access rights

You should have Administrator access permissions on the computer to install Deep Log Analyzer if you are
installing on Windows NT, 2000 or XP computer.

Deep Log Analyzer also installs or updates Microsoft MDAC to version 2.8. MDAC installation is considered as a
Windows system update. Some operating systems already have MDAC 2.8 installed. In such cases DLA will not
install MDAC.

Run setup program

To install Deep Log Analyzer run dlapro.exe (for Professional Edition), dlatrial.exe (for trial of Pro edition) or
dlatrial.exe (for trial of Free Edition). If it shows a message that you need Administrator rights contact your
system administrator for installation or log in to another account with Administrator access permissions and
run installation from there. You can also use right click on the installation file in Windows Explorer and click
Run As... to open installation as Administrator user.

Select folder where you want to install program, Start menu group name. It will copy all required program
files.
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Sample project

Deep Log Analyzer also installs Sample Project and sample log file for this project. Mark check box on the final
installation window to start Deep Log Analyzer and open Sample Project for your review.

Registration and activation

If you install the Professional Edition it will ask you to enter registration information to activate it on this
computer when you first start it. You will have to enter your registration code that you received in email after
purchasing this program.

After you enter the correct registration information Deep Log Analyzer will start and open Sample Project



Top Level Intro
This page is printed before a new

top-level chapter starts

Part

VI



Deep Log Analyzer20

© 2006 Deep Software Inc.

6 Exploring the Interface

6.1 Exploring the Interface

The area of the Deep Log Analyzer interface where reports are displayed.

The Deep Log Analyzer's interface is made up of the menu bar, three toolbars, four individual areas, referred
to as panes, and the application's main work area, referred to as the Report Area. The following image labels
each interface element. Most elements can be repositioned, closed, or otherwise customized.

For more information on customizing the toolbars, refer to Customizing Toolbars and Menus.

For more information on customizing the display of the panes, refer to Customizing Panes.

For more information on the Report Area, refer to Reports Overview.

6.2 Customizing Panes

Displays the list of reports, predefined and custom, for an open project. Click a report to view it in the Report
Area.
The area of the Deep Log Analyzer interface where reports are displayed.
Provides you with a quick and easy way to generate date-based reports. Also, indicates by colour the days that
have log file data stored in the database.

Contains buttons to assist you in generating reports. For example:
To generate a report using predefined date ranges, select one from the drop-down list.

To generate a report that displays data closest to today's date, click the Near Today button .

To generate a report that displays data from all dates found in the log files, click the All Dates button .
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To generate a report for a specific date range, click the Enter Dates button  to open the Report Date
Filter window and specify a date range.
Contains quick, one-click access to commonly performed tasks. Sections include Open a Project, Analyze
Website, Reports, and View.
You can customize the look of the Tasks pane by clicking the Close Section  and Open Section  buttons.

As shown in Exploring the Interface, the Deep Log Analyzer interface is made up of toolbars, menus, and
panes. You can customize panes by docking and undocking them, repositioning them on the screen, setting a
pane to auto-hide, and closing docked panes.

The five panes in Deep Log Analyzer are:
· Reports
· Calendar
· Tasks
· Tip of the Day
· Report Help

Tip:  Toolbars and menus are discussed in Customizing Toolbars and Menus.

Panes are initially docked, but can be undocked and positioned anywhere you like on the screen. When you are
moving floating panes around the window, the pane can be 'snapped' automatically into a predefined position
on the screen. This makes it easier to arrange the different floating panes.

 

To dock or undock a pane, or to reposition a pane on the screen:
· Drag the pane by the title bar.

If it's docked, the pane will become undocked.

If it's undocked and you wish to dock it, reposition the pane until its outline indicates that it's docked.

If it's undocked and you wish to reposition it, drag the pane around your screen.

Tip:  Double-clicking a floating or undocked pane docks it to its last docked position.

 

To set a docked pane to auto-hide:

· Click the Auto-Hide icon  in the title bar of the pane.

To turn off auto-hide on a docked pane:

· In the title bar of the auto-hidden pane, click the Auto-Hide icon .

To close a docked pane:

· Click the Close icon  in the title bar of the pane.

6.3 Customizing Toolbars and Menus

The Standard toolbar contains buttons for common operations from the File menu: New Project, Open Project,
Close Project, Print, Print Preview, Project Settings, and Import Log Files. 

Use these buttons just as you would use the equivalent File menu commands.
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The Report toolbar contains buttons for common operations from the Report menu: Back, Forward, Previous
Report, Next Report, Refresh, Select Dates, Close Report, Export to HTML, and Properties.

Use these buttons just as you would use the equivalent Report menu commands.
The View toolbar contains buttons for common operations from the View menu, allowing you to display the
open report in full-screen mode, show or hide the Reports, Calendar, and Tasks panes, and open the
Customize dialog box.

Use these buttons just as you would use the equivalent View menu commands.

As shown in Exploring the Interface, the Deep Log Analyzer interface is made up of toolbars, menus, and
panes. You can customize toolbars and menus by docking and undocking them, repositioning them on the
screen, and changing which buttons are available on them.

The three toolbars are:
· Standard
· Report
· View

Tip:  Panes are discussed in Customizing Panes.

To undock a toolbar:
· Drag the toolbar by its gripper (circled in orange below).

To dock or reposition a toolbar on the screen, drag the toolbar by the title bar.

To change which buttons are available on the toolbars:
· Open the Customize dialog box by doing one of the following:

o From the View menu, click Customize.

Or,

o From the View toolbar, click the Customize button .

Tip:  An easy way to add additional buttons to a floating toolbar that are found in a different menu is
to open the Customize dialog box and drag menu items from the list on the Commands tab to
the toolbar.

Tip:  Hold down Alt key and drag toolbar buttons to change their position
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7 Analyzing Your Website

7.1 Creating a New Project

Before you can analyze a website's information, you need to set it up as a project in Deep Log Analyzer. To
create a project, use the Project Settings wizard.

Note:  For a full description of the Project Settings wizard's windows, refer to the Project Settings
Wizard Overview.

To open the Project Settings wizard and create a new project:

1.Click Create New Project in Tasks Pane. Or from the File menu, click New Project. The Project
Settings wizard opens.

2.Name your project in the Name window and then click Next.

3.Define the location of the project's log files in the Log Files window and then click Next.

If your log files are located locally:

a.Select Log files are located locally.

b.In the Web server log files list area, click to browse for the log files.

c. In the Open window, add one or more log files, and then click Open.

d.In the Log Files window, click Next.

Tip: Use the asterisk (*) A character that can be used to represent one or many characters when
conducting a search. The question mark (?) represents a single character, and the asterisk
(*) represents one or more characters.wildcard A character that can be used to represent
one or many characters when conducting a search. The question mark (?) represents a
single character, and the asterisk (*) represents one or more characters. to gather data
from all the log files in a folder. For example, C:\Program Files\Deep Log
Analyzer\SampleLogs\*

If your log files are located on a remote server:

a.Select Log files are located on FTP site.

b.Type the FTP server's web address in the Server address field. For example,
ftp.deep-software.com

c. Type your FTP user name and password in the corresponding fields.

d.In the Log Files field, type the path and name of the log files, making sure you include all the
folders in the path.

Tip: Use the asterisk (*) wildcard to gather data from all the log files in a folder. For example,
logs/deep-software.com/*

4.Enter your websites's domain name and other site information in the Site window and then
click Next.

a.Type the site's domain names, including aliases and static IP Addresses.

Note: In most cases you may leave default values for the rest of parameters on this page

b.To keep track of referrals to your website from other websites and ignore referrals from your own
site, check Remove Self Referrals

c. To gather data from the log files for the specified website, check Exclude requests to other virtual
domains.
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Note: At times, companies may have more than one website running on a web server. The
data from all websites can be written to the same log files. This option in Deep Log
Analyzer ensures that your reports and analysis is only on the specified website.

d.Type the site's start page. Examples are index.htm or default.asp.

e.Type the number of hours to add to the time in your log files in Time Adjust field.

Note: This is only required if the web server is located in a different time zone and the
absolute time in reports is important for you.

5.Select sessions and visitors tracking method in the Analysis window and then click Next.

a. It is recommended to select DeepTracker method as it is the most accurate and provides extra
reports about client browsers.

b.Choose a date format from the Date Format list. It's recommended to leave Auto setting in most
cases.

c. Type the site's visit timeout value. Visit timeout is a certain amount of idle time, i.e., the user has
not clicked any links on your site, the user's visit is considered finished.

6.Specify what action to take with URL parameters in the Dynamic Content window and then
click Next.

a.Mark Retain URL Parameters check box if the site uses dynamic pages (database driven design)
or other URL parameters and you want to keep track of the pages requested with different URL
parameters as separate pages. Also mark this check box if you want to track URL parameters to
see the results of different marketing campaigns. For more information click here

b.Mark Remove URL Parameters from Referral Pages Reports to reduce database size and
increase import and reports speed

7.Specify what to exclude from import in the Exclude window.

a.Mark Do Not Import Hits on Graphics Files to improve import speed in case the accurate
reports on website's bandwidth are not important for you

b.Mark Do Not Import Error Hits check box if you don't need to see reports on site errors.
Excluding this information will create more clear reports and will reduce database size and improve
import speed. 

c. Enter the list of your company's external IP addresses or IP range (company network) to exclude
visits from your company from the analysis.

8.Specify what period of logs you would like to keep in the database in the Database Window

9.Setup schedule if you want this report to run automatically in the Schedule Window

10.Click Finish & Analyze button to close New Project wizard and start logs import right away.
Or click Finish to close wizard and import logs later.

Notes:

- You may change any of the settings entered here later for the created project. Click View/Edit Project
Settings in Tasks Bar to do it. In most cases you will need to reimport log files after changing project settings.

7.2 Project Settings Window

7.2.1 Project Settings Overview

The Project Settings window allows you to identify the website you wish to analyze by giving it a quick and
easy name. It also allows you to specify the location of the site's log files, define the site's information, specify
the content you wish to include and exclude when analyzing the website and generating its reports.

The Project Settings wizard is made up of six windows/tabs:
· Name
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· Log Files
· Site
· Analysis
· DeepTracker Code
· Dynamic Content
· Exclude
· Database
· Schedule (Pro edition only)

When you create new project, all settings window are shown one after another and include the following
navigation buttons:

· Back and Next allow you to navigate between the wizard's windows.
· Cancel closes the wizard without saving any of your changes.
· Help opens this help file.
· Final window of the wizard also contains:

· Analyze Now button that closes the wizard and starts log import procedure right away
· Finish & Save button that closes the wizard without importing logs. To process logs later click

Import Log Files in Tasks Pane

When you open project settings of the previously created project, all these windows are displayed on separate
tabs of the same Project Settings window and you can access them in any order. To change project settings

click ( ) button in toolbar.

If you edited existing project's settings you may be required to reimport log files in order the changed settings
reflect on your reports. This happens, for example, when you change such project settings as log files list or
domain name. If you changed such important settings Deep Log Analyzer will prompt you when you click OK in
Project Settings Window:

Click Yes to reimport log files with changed project settings. Click No to continue with previously imported
logs. You may reimport logs later manually. Click Cancel to continue editing project settings.

7.2.2 Name tab

The Name tab is the first tab in the Project Settings Window
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It contains the following field:
· Project Name field: type an easily identifiable name for your website. The following characters are not

allowed in your project name: / : * " < > |

New project will be created in the subdirectory of Data Storage with the same name. The name must be
unique.

 

See Also

Project Settings Overview

Creating a New Project

7.2.3 Log Files tab

The Log Files tab is the second tab in the Project Settings window. Deep Log Analyzer can access web server
log files either locally or through FTP. This  window contains the following settings.
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For local log files
· Log files are located locally (or on shared location in LAN): check if the project's log files are

located on your hard drive or your local area network.
· Web server log files list: click to enter the location of the project's log files. Allows to enter multiple

log files in separate lines.

· : click to add a new log file name. Once you click this, an ellipsis ( ) displays in the Web server
log files list area, allowing you to browse for the log file name instead of typing the log file's file path
and name. Select one or more log files and click OK to add the to the project's list.  To select multiple
files in Open dialog click on multiple log files while holding Ctrl button. Press Ctrl+A to select all files
in current folder.

· : click to remove the selected log file from the list of log files. The file remains on your hard drive,
but its data is not included in your website analysis.

· Use wildcards to gather data from multiple log files in a folder. For example, C:\Logs\ex0404*.log
will import all log W3C format log files for April 2004. This ensures that if new log files appear in the
folder later they will be imported when you click Import Logs. When you click Import Logs program
parses only the files that are not yet fully loaded into project's database.

Tip: Double click on the line in list to enter into edit mode

For log files on FTP server

Deep Log Analyzer can download log file(s) via FTP and parse them locally. If your website is hosted by a
hosting provider company, they usually provide access to so called row log files via FTP. Ask them for details if
you are not sure how to access your log files via FTP.
Every time you click Import Logs in your project Deep Log Analyzer downloads new or changed log files from
the FTP server to \logs subfolder of project's folder. Then it processes downloaded log files as it does with the

log files located locally.
· Log files are located on FTP site: check if you website's log files are located on the remote site and

can be accessed via FTP.
· Server address: type the FTP server's address. In most cases your FTP server's address is the same as

your website's HTTP address, but with  FTP instead of WWW part and beginning with FTP:// instead of
HTTP://. For example for http://www.deep-software.com website FTP server's address would be

ftp.deep-software.com or ftp://ftp.deep-software.com. You may also try domain name only: for

example, deep-software.com. If you still can not access your FTP server, ask your system administrator
or hosting services provider.

· Port: type the FTP connection port number. Default port used by FTP servers is 21.
· User name: type your FTP login user name.
· Password: type your FTP login password.
· Log File(s): type the path and name of the log files, making sure you include folder in the path.

Include wildcards to include more than one file in the import list.

Tip:  Use the asterisk (*) wildcard to gather data from all the log files in a folder. For example, /logs/
deepsoftware.com/*

· Passive mode: check to connect in Passive Mode. Should not be marked by default. Mark if you're
behind a firewall and DLA can not connect to FTP server.

Tip:  For a detailed explanation of Active vs. Passive FTP connections, refer to http://www.slacksite.
com/other/ftp.html.

Examples of the files you should import in Deep Log Analyzer

MS IIS web server on MS Windows:

ex040424.log, ex040424.log.gz or ex040424.zip

These are files in W3C format. The name indicates the date range in YYMMDD format, and it typically spans
one day or one month. The above example would contain all web server's work for  April 24, 2004.  Files with
gz and zip extension are compressed files that also can be processed by DLA.

Apache web server on Linux:

http://www.deep-software.com
http://www.slacksite.com/other/ftp.html
http://www.slacksite.com/other/ftp.html
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access or access_log or access_log.txt, etc.    - This is the current log file.

access.1.gz or access_log.1.gz, access.2.gz, etc.   - These are older rotated logs. Depending on the

rotation schedule you may or may not want them. it's safest to grab them all and let ClickTracks work out the
dates.

 

Note

- If you change any of the settings on this page for the existing project you have to reimport log files in order
the changes to take effect.

See Also

Project Settings Overview

Creating a New Project

7.2.4 Site tab

The Site tab is the third tab in the Project Settings window. 

It contains the following fields:

· Website URL: URL of the website root
· All Domain Name(s): type the site's domain names, including aliases and static IP Addresses.

Separate your entries with a comma. It's recommended to enter domain name without www part, for
example: deep-software.com. This information is mainly used to filter our self referrals if the next

option is on. If you still see referrals from your website's IP address or host name in the referrals
reports, add that name and/or IP address to this list.

· Remove Self Referrals: check the box to keep track of referrals to your website from other websites
and ignore referrals from within your own site. It is recommended to keep this option on since there is
not much useful information in self referrals. You should instead concentrate on tracking referrals from
other websites.

· Exclude requests to other virtual domains: check the box to gather data from the site's log files
for only the specified website.

Note:  At times, companies may have more than one website running on a web server. The data from
all websites can be written to the same log files. This option in Deep Log Analyzer ensures that
your reports are generated based only on the specified website's data. Deep Log Analyzer
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distinguishes virtual domains by cs-host field in IIS W3C log file. For Apache this field is the
virtual server name or %v in the log directive line.

· Default Page: type the website's start page. Examples are index.htm or default.asp.  Default page is
the page which is displayed if the visitor does not specify a page name after your domain name. When
requested page name is empty in log file, Deep Log Analyzer uses the name entered here for the
reports

· Time Adjust: type the number of hours to add to the time in your log files.

Note

- If you change any of the settings on this page for the existing project you have to reimport log files in order
the changes to take effect.

See Also

Project Settings Overview

Creating a New Project

7.2.5 Analysis tab

The Analysis tab is the fourth tab in the Project Settings window

The following options determine how Deep Log Analyzer identifies unique visitors. DLA applies heuristic
algorithm to distinguish different visitors by IP address or host name, user agent and other values. Identifying
visitors is important as it allows to correctly determine such values as user loyalty and visitors return rate.
Accuracy of most reports depends on how correctly unique visitors are identified.

· DeepTracker method

DeepTracker method is the most accurate tracking method available in web analytics today. This
method uses javascript to set permanent user ID cookie on visitors computer. When the user with
this cookie returns to the website later it's precisely identified as a returning visitor regardless of his
IP address.

This method uses session cookies for sessions tracking. This allows Deep Log Analyzer to identify
series of different page views and hits as a visit

DeepTracker Code inserted in web pages collects extended client information about visitors that is
shown in these reports:

ü Screen Resolution;
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ü Color Depth;
ü Javascript Support;
ü Screen Resolution;
ü Screen Resolution;

Requirements:

1.This method requires DeepTracker Code inserted in all pages of the website. DeepTracker code is a
small piece of HTML code. If your website design uses includes for displaying header on each page,
it is the best place to insert the DeepTracker Code. DeepTracker code should be inserted right
below <body> tag, although other positions will work too.

2.Put dla_tracker.js and dla_tracker.gif files in the root folder of your website. These files can be
found in "{Program Files}Deep Log Analyzer\DeepTracker\" folder. If your website has more than
one directory with web pages, these 2 files should be uploaded to those folders as well in case
DeepTracker Code was inserted in web pages there.

3.Cookie field must be present in log files. You should set up log format on the web server to include
Cookie filed. This is done differently on MS IIS  and Apache. Follow these instructions to set up
cookie field in your web server.

4.If any of above requirements is not met Deep Log Analyzer will use IP Address+User Agent tracking
method.

· IP Address+User Agent method

This method uses a combination of visitor's IP address and User Agent (OS +Browser) to identify
visitors and sessions. It does not require any changes in website design, although it is less accurate.
IP addresses can change over time even during single visit. This fact inflates number of unique
visitors and visits the software reports.

· Use User Names rather than IP Addresses...: check to identify visitors by user name instead of an
IP Address.

Note: This option allows DLA to identify visitors very precisely, but only applies when users log in to
your website. This works only on secure sites that require user authentication. Only users
authenticated by methods that record the user names in web server log file will be recognized,
for example is Apache server '.htaccess' method. If there is no value in this filed DLA still
applies its standard user identification algorithm.

It also contains the following fields:

· Visit Timeout: type the site's visit timeout value. Visit timeout is the amount of idle time, i.e., when
the user has not clicked any links on your site, the user's visit is considered finished.

Note:  You only need to enter a value in the Time Adjust field if your web server is located in a
different time zone and if the exact time of the hits is important to you.

· Date Format: choose a date format. Options are Auto, MM/DD/YY, DD/MM/YY, and YY/MM/DD.

Note:  If you choose Auto, Deep Log Analyzer will try to determine the date format native to the log
file, as log files may differ between web servers. Take into account that it's not always possible
to correctly determine the log file's date format. For example, DLA can not automatically
determine date format of 01/06/04. If you see any inconsistent dates in the reports you should
view the log file and define date format here.

Note

- If you change any of the settings on this page for the existing project you have to reimport log files in order
the changes to take effect.

See Also

Project Settings Overview

Creating a New Project

DeepTracker Setup



Deep Log Analyzer32

© 2006 Deep Software Inc.

7.2.6 DeepTracker Code tab

DeepTracker Code tab only exists in Project Settings if DeepTracker method is selected on Analysis tab.

This window shows the DeepTracker Code generated for your website. This HTLM fragment should be inserted
in every page of your website. 

· Copy to Clipboard: click this button and then paste the code in your website HTML files right below
<body> tag. This code should be inserted in all pages of the website. If your website design uses includes
for displaying header on each page, it is the best place to insert the DeepTracker Code.

Tip: If it is impossible to insert DeepTracker Code in ALL pages of the website try to insert it at least in
the main page and possible landing pages (entry pages) of the website.

· Locate Files button opens Windows Explorer in the "{Program Files}\Deep Log Analyzer\DeepTracker\"
folder that contains dla_tracker.js and dla_tracker.gif files. Upload these 2 files to all directories of your
website that contain pages with embedded DeepTracker Code.

· Check DeepTracker : click this button to verify if DeepTracker Code is correctly installed on the website.
Deep Log Analyzer will check for DeepTracker Code in the HTML code of site's main page and presence of 
dla_tracker.js and dla_tracker.gif files in website's root folder. Deep Log Analyzer will report if any problem
found. Fix them and click Check DeepTracker code button again to make sure that tracking is set up
correctly.

Note: As a next step you should make sure that cookie field is enabled in web server log files. Read
here how to enable cookie field in web servers.

See Also

Project Settings Overview

Creating a New Project

DeepTracker Setup

7.2.7 Dynamic Content tab

The Dynamic Content window is the tab in the Project Settings wizard. 
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It contains the following settings:

· Retain URL Parameters: mark this check box if the site uses CGI, ASP or other URL parameters and
you want to keep track of the pages requested with different parameters as separate pages. You may
want to do this if you have a dynamic website, i.e. page content is stored in database and is shown on
the web page depending on the URL parameter(s). Such dynamic sites usually employ some kind of
database driven content management system.

For example, such request as /showarticle.asp?arctice_id=123, /showarticle.asp?

arctice_id=382 deliver to the visitors different articles  identified by arctice_id URL parameter. /

showarticle.asp file is used here only as a template, but actually displayed page content varies

depending on arctice_id used

You can also use this feature to track the results of marketing campaigns by defining unique
parameters for different campaigns. For example, use URLs like http://www.site.com?
campaign=google5 for different campaigns. Then add "campaign" to the list of retained parameters
below. This allows you to track how many times users entered your website through such links.

· Retain only parameter from the list: mark the check box and enter the parameters separated by
comma. You should list parameter names that identify webpage's content. In the above example it is
article_id. DLA will keep track of the pages called with different parameter values as different pages in
appropriate reports, such as Top Pages Report.

· Remove URL Parameters from Referral Pages Reports: Set this option not to display referrer
URLs in such reports as Referring Pages Report without URL parameters. Setting this option will
improve DLA performance and requires less space in the project's database. But it will cause that some
incomplete URLs in the referrals reports. For example, referrer htpp://www.site.com/page.asp?
prm=34876&sessionid=1234233456ert123 will be shown simply as htpp://www.site.com/page.asp

See Also

Project Settings Overview

Creating a New Project
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7.2.8 Exclude tab

The Exclude window is the tab in the Project Settings wizard.

It contains the following settings:

· Do not import hits on graphic files: mark this check box to filter out hits on graphic files. This allows
you to improve import speed about 3 times or more and have much smaller database depending on the
amount of graphics on your site. Although some standard reports will be unavailable, such as Accessed
Graphics report

Note: There is not much useful information about visitors behaviour in hits on graphic files, since such
reports mainly analyze hits on web pages. But you may decide to import graphics hits if you need such
information as bandwidth, as graphics can consume a lot of site's bandwidth, or you want to specifically
analyze what graphic files where accessed by visitors.

· Do not import error hits: mark this check box to filter out hits with error status.

Note: Such errors include status codes 400 and more, such as 404 File Not Found, 401 Unauthorized,
500 Internal Server Error, etc. If this option is enabled all reports in Deep Log Analyzer will be based
on successful hits only. Although some standard reports will be unavailable, such as "Page Not Found
Errors", "Server Errors" in Diagnostic group. You may create another project with this option disabled
to view these reports.

· Do not import  hits from these Addresses: enter the list of IP address or host names, hits from which
will not be analyzed. Your company's employees can visit your website often and it's a good idea to exclude
such hits from analysis, as you want to analyze the behaviour of your customers or prospects. You may
exclude individual addresses or whole IP segments using wildcards, for example: 25.26.56.83, 25.26.56.*

Excluding visits from inside your company allows you to concentrate only on customer visits and clear
and precise reports

· : click to add a new address to the list

· : click to remove the selected entry from the list

Note: You need to enter either IP addresses or host names in this list, whichever your log files contain.
 

See Also

Project Settings Overview

Creating a New Project
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7.2.9 Database tab

The Database window is the tab in the Project Settings wizard.

This window contains database maintenance settings for current project.

· Keep only this last period of logs in database: mark it to enable database pruning. Deep Log
Analyzer keeps all hits data in internal database. The more hits is stored in the database, the bigger
and slower it becomes. This option allows to delete older data from the database automatically.

Enter the number of days, weeks or months. Deep Log Analyzer will keep this most resent period of
logs in the database. All older data will be discarded. 

· Prompt user before pruning the database: if this checkbox is marked, Deep Log Analyzer will
ask user confirmation before deleting old data.

Note: The actual deleting of data in project's database happens after the import of new log files, when
you click Import Log Files button.

Note: After the data is deleted from the database reports for that corresponding period are not
available anymore. If you need to view reports for older periods, you should still have it in old
log files. Create another project in Deep Log Analyzer and import your older log files there.

Tip: Deleting data about old hits from the database allows Deep Log Analyzer to create reports faster. 

To keep reports for old periods for archival reasons you can:

· export reports for older periods to HTLM and keep html files. Then delete old data from the
database.

· create other reports in Deep Log Analyzer for older years/quarters

Tip: You can delete old data from the project manually. Settings in this window are not required then.
Click Delete Imported Logs from database. Select "Prune Database up to" in Delete Data Window
and select the date before which you want to delete the hits.

See Also

Data Storage

Project Settings Overview

Creating a New Project
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7.2.10 Schedule tab

The Schedule window is the tab in the Project Settings wizard to setup automatic export of reports.

This window makes it easy to setup a schedule for automatic logs processing and reports export.

When Deep Log Analyzer runs the project by schedule it downloads and processed new and updated log files.
Make sure you use the asterisk (*) wildcard in file names on Log Files tab so that Deep Log Analyzer could pick
up newly created log files. 

Then it exports reports for the selected dates info framed .html files. These .html reports can be published on
the website

· Run Task by Schedule: mark this check box to enable automatic processing of this project. You
can can see below what schedule is currently set and when is next run.

· Runs As: Enter Windows user name here. Deep Log Analyzer will run the project under this user
account.

· Run only if logged on: if marked the project will run only if this user is logged on the
computer at the scheduled time. If you want the project to run in unattended mode, such as
on a server, you need to clear this check box. In this case you will need to click Set Password
button and enter the user's password. It is safe, as Deep Log Analyzer does not save the
password.

· Click Change button to open edit project's schedule in this window:
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· Schedule Task: specifies how often
the scheduled task runs. It can be
Daily, Weekly, Monthly and so on.

· Start time: specifies the time of the
day when the task is run.

· Depending on whether Daily, Weekly
or other is selected in the first list, you
can change more task settings below,
such as selecting particular days.

· Select Show multiple schedules
check box to enter more then one
schedule for this project.

Most typical schedule for running reports
would be daily. This allows to get
updated reports for your website
automatically every day for your review.

It's easy to set it up. Select Scheduled
Task: Daily; Enter Start time: 10:00 AM
for example, enter Every: 1 day. Click
Ok.

Generate reports

This section controls what reports will be exported to .html files

· For Date Range: Select dates interval from the list for which the reports will be created in HTML
format. You can choose any dynamic range from the list. The actual dates in a dynamic range
change as new logs get imported and current date changes. For example, you can select Last 28
Days, Last Week of Logs, etc. 
Choose <Select Date Range> to enter dates absolute date range manually.

· Export List Profile: Select from the list what reports to export in HTML. Export list profiles here
are the same as used in Export Reports List window. You can select any previously saved export
profile here. 
Choosing <Select Reports...> in the list allows you to pick out reports manually from the list. 
Selecting All Reports will export all reports available at the time of export, even you add some
custom reports later on.

· Export selected reports to this HTML file: select or enter index file name where you want the
report to be exported. It's recommended to specify separate folder for the report, as it will create
multiple .html, .png files and sub-folders in the selected folder.
The folder entered here might not exist. The program will create all needed folders.

Note: Deep Log Analyzer uses Windows Scheduler service for running scheduled projects. This service must
be started in order for reports to run automatically. You will also see multiple tasks in Windows Control Panel-
>Scheduled Tasks with names such as this: "DLA Taks.4d35f394-3196-48e5-9521-907d01000c45". These are
tasks used internally by Deep Log Analyzer.

See Also

Exporting Reports

Project Settings Overview

Creating a New Project
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7.3 Importing Log Files

When you import log file data, log files are parsed and data is copied to the relational database in Microsoft
Access format called hits.mdb, which is located in the project's folder. Supported log file formats include CLF

(Linux, Unix web servers) and W3C (Microsoft IIS web server).

When you import log files, Deep Log Analyzer does not re-import the complete log file. It only imports new
data found in the specified date range that is not already in the database. For example, you may run Deep Log
Analyzer every day and then choose to import the new log file data. Deep Log Analyzer imports the data from
the previous day and refreshes the reports so that they include the new log file information.

Deep Log Analyzer will not import records for the overlapped periods of time form log files. This would cause
duplicate hit records in the database and inaccurate reports. Every time you click Import Logs program starts
import from the end time of logs already in database.

Deep Log Analyzer is able to process compressed log files without unzipping them. Supported compression
formats include .zip (Windows) and .gz (Linux, Unix) formats.

Tip:  Compress log files that are stored on the web server, as they take much less space and are
faster to download

Importing log files can be done in one of the following ways, depending on how you defined the location of the
site's log files when you created the project:

Log file location How website's logs are
saved

What to do

Used wildcards Data written to one log
file

From the Standard toolbar, click Import Logs . DLA will
import only the new records of the log file that appeared since
last import. No overlapping time intervals will be imported

Used wildcards Data written to many
files

From the Standard toolbar, click Import Logs . DLA will
import only the new parts of the log files and new log files that
appeared since last import. No overlapping time intervals will be
imported

Named an
individual file

Data written to one log
file

From the Standard toolbar, click Import Logs . DLA will
import only the new records of the log file that appeared since
last import. No overlapping time intervals will be imported

List of individual
files

Data written to many log
files

Add the new log files to the list. If you did not use wildcards in
log file paths DLA is not be able to find newly created logs. You
will need to add them to the list manually. No overlapping time
intervals will be imported

Note:  Each project database has a size limit of 2 gigabytes (GB), which corresponds to about 3 GB of
uncompressed log files. If your project's database size reaches the 2 GB limit, you should start
a new project. You may want to consider creating new projects for shorter date intervals, e.g.,
every quarter, month or week. 
To make database size considerably smaller mark Do Not Import Graphics check box in Project
Settings
Also you will need to set up automatic clean up of old data from the database in Project
Settings here

Note:  When you import log files that are located on a remote FTP server, Deep Log Analyzer first
downloads the new or updated log files to \Logs subfolder in the project's folder on the hard

drive, and then imports them into the database as it does with local logfiles.

Note:  Deep Log Analyzer can download and import log files every day for you automatically. Read
here how to set up the project to run by schedule
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7.4 Filtering Reports by Date

Deep Log Analyzer allows you to view reports data by any timeframe desired, from 1 day to the entire period
of time for which logs data exists in the project's database, or any part thereof. The Calendar feature makes it
easy to specify either a standard timeframe (such as a day, week, month), or any custom timeframe.

There are several ways to filter reports based on the date: selecting the dates on the calendar, selecting
standard date range from the list or directly enter begin and end dates in Report Date Filter window.

Selecting date range in Calendar

It's the easiest way to view the reports for desired date range. To filter reports based on the date using the
calendar:

1. Select the month on which you want to base the report by scrolling through the months (buttons are
circled in orange below).

2. The dates for which logs data exist in database are highlighted with blue color
3. Click on the individual day to view report for that single day
4. Click and drag mouse pointer to select a desired date range for the report
5. If Calendar Bar is hidden click View-Calendar menu to make it visible

After you change date range selection in calendar, report on the active tab is refreshed immediately,
displaying the data for the selected date range.

 

Selecting standard date range

To view report by a standard date range such as a day, week, month, etc. select the desired period in the drop
down list in Calendar Bar, and the report's data will change accordingly.

The following standard date ranges are available:

Range Description

All Dates Use all dates in the imported log files

Following standard dates ranges are calculated based on the current date

Today Current day. May be the last day of log if there is no logs for today

Yesterday Previous day

This Week Week starting Sunday to Saturday or whatever the first day of week is
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Last Week Full previous week

Last 7,14,21,28 Days Previous selected number of days including today from midnight to midnight

This Month Current month from day one to the end of the month

Last Month Full previous month

Following standard dates ranges are calculated based on the last date of imported logs. This is
useful for analyzing older projects for previous dates that don't include current date

Last day of Log Last day of imported log file(s)

Day before last day of Log Day before last day of log

Last Week of Log Full last week of log

Previous Week of Log Full week before last week of log

Last 7,14,21,28 Days of
Log

Selected number of days including today from midnight to midnight

Last month of log Full calendar month from day one to the end of the month that includes end of log
date

Previous month of Log Full calendar month before the last month of log

 

Click Near Today button in toolbar to select either today date or last day of log if there is no logs for today.

Click All Dates button in toolbar to display reports for all days available in imported log files

Direct dates input in  Report Date Filter window

To filter reports based on the date using the Report Date Filter tool:

1. In the Calendar pane, click the Enter Dates button . The Report Date Filter window opens.

Tip:  As well as being able to select a report date range, the Report Date Filter tool also displays the
date range of the logs stored in the database.

2. Select a date range from the From and To fields.
3. Click OK. The Report Date Filter window closes.

The currently opened report is refreshed, displaying the data for the selected date range.

Notes

- Date range changes apply only to the report on active tab. Reports on other tabs are not affected and still
show report for their respective date ranges

- After selecting a date range, all new reports you open will display data for that period until either the project
is closed or a different date range is specified

Tip:

You may compare same report for different date ranges to find out how important statistics change over time
or what effect some changes had. Open the report on two separate tabs and select different date range for
each tab. Then switch between tabs to compare the reports visually.

7.5 Analyzing Your Website FAQs

For most up-to-date version of FAQ please visit our website: http://www.deep-software.com/faq.asp

http://www.deep-software.com/faq.asp
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Also read the Knowledgebase at our Online Support Center

What volume of web server logs can be imported by Deep Log
Analyzer?

Deep Log Analyzer imports data from log files into MS Access database. It uses separate database mdb file for
each project. A single mdb file can have size up to 2 Gb. Data in a database is organized in much more
efficient way than in raw log files since database is designed according to normalization rules. This is why log
files take less space in the database than their original size. Also Access database can be compressed to take
even less space. Also it is recommended to filter out graphics requests in project settings in order to have a
smaller database.

How do I optimize Deep Log Analyzer to work faster?

Take into account that Deep Log Analyzer uses an advanced report caching technique for opening reports
faster. This means that a report's query is actually executed only when you open report for the first time. Next
times report has been loaded from a fast cache and it takes much less time. It allows you to browse your
website statistics complex reports in real time without any delay. Here are some additional advices to make
Deep Log Analyzer even faster:

1.Consider not importing graphics requests into the project database. Unmark corresponding check box on
Excludes tab in Project Settings. Graphics requests usually take about 2/3 or more of all hits and have very
limited useful information in them. Excluding improves logs import and report creation speed several times
and makes your project database a few times smaller.

2.Do not import into the database hits generated by visitors from your company. Such "inside" visits can
become a substantial part of all recorded web site activity. Excluding such hits improves import and report
execution speed and results in less database size as well as makes your reports more accurate since they
include only activity of your real visitors. Enter your companies external IP addresses in list on Exclude tab
in Project Settings.

3.Consider creating new projects more often. Instead of importing all log files for your web site life time in a
single project in Deep Log Analyzer create new project every quarter, month or even week (for larger web
sites). Keep old data in other projects so that you could concentrate on the situation on the website. This will
make reports much faster and easier to work with by eliminating data for unnecessary time periods. Use
wildcards to specify log files sets for particular dates, for example c:\logs\ex0406*.log will import only log
files for June 2004.

4.When importing log files click Background button located in import dialog window. This will minimize Deep
Log Analyzer to system tray and it will continue importing process in the background allowing you to work
comfortably with other programs. Deep Log Analyzer will be restored from background automatically when
log parsing finishes.

5.Make sure your computer configuration matches the minimum system requirements. Basically Deep Log
Analyzer performance depends most on two main factors: hard drive speed and CPU speed. Computer also
should have enough RAM - 256 to 512 Mb is appreciated.

How can I make Deep Log Analyzer recognize more search
engines?

Deep Log Analyzer currently can recognize more than hundred most popular internet search engines like
Google, Yahoo, MSN, etc. In log file it can find search engine name and key phrase that referred visitor to your
website. If you receive hits from some local search sites, you can add them to search engine definitions in
search_engines.ini file.

They will then appear in all search engine reports in Deep Log Analyzer. Open search_engines.ini file in
Notepad, add new line in the format like SE114=MySearchEngine into [SearchEngines] section. Than add new
[MySearchEngine] section at the end of file and list the values that tell how to recognize hit from this search
engine:

EngineIndicator1=mysearchengine.com
EngineIndicator2=mysearchengine.net
SearchPhraseIndicator1=?q=
SearchPhraseIndicator2=&q=

http://www.deep-software.com/support.aspx
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This allows to recognize referrer URL like http://www.mysearchengine.com?q=phrase1 as a hit referred by
MySearchEngine with search keyword "phrase1" Search engine definitions are processed at the time of log file
parsing, so the newly added definitions will work only for logs that you import later on. You may re-import log
files to apply changes to all imported data.

It is recommended to back up ini file after editing or it will be overwritten if you reinstall the program. Or just
keep a copy of added records in a separate file.

For more information please read this topic: Search Engine Definitions

How to add browser, spider or OS definitions?

You can add custom browser, search engine spider and OS definitions in user_agents.ini file. Look at
Unrecognized Browsers report. It shows all User Agent fields found in imported log files that are not described
in user_agents.ini. If you get lots of hits from some kind of user agent (for example new download manager)
that Deep Log Analyzer does not recognize, you can add custom definition for this user agent. It will be then
recognized as a standard browser. Definitions should be entered in the following format in [Browsers] section:

BROWSERXX=[Name],[Log file stamp used to find it]

For example: 

BROWSER22=ReGet (downloader),ReGet

The same format is used for search engine bots ([Spiders] section on user_agents.ini) and OSs ([Platforms]
section in user_agents.ini).
Back up edited ini-file as it can be overwritten when you install new version of Deep Log Analyzer.

For more information please read this topic: Browser, Spider and OS Definitions

Can I create my own reports in Deep Log Analyzer?

You can design you own custom reports using SQL queries. It is potentially possible to create report on any
aspect of the website usage you may ever need since all data from log files is imported in a well designed
relational database. You may create new report based on any standard report. In this case SQL query will be
copied to your new report and you'll be able to edit it. Deep Log Analyzer has advanced SQL query editor with
syntax highlighting. To design good and useful reports you have to become familiar with database structure
that you can see in diagram.jpg file provided with the software. Contact us in case you require assistance with
designing your custom reports.

For more information please read this topic: Creating Custom Reports

What log file do I need? Where can I get the log files?

Deep Log Analyzer needs web server log files in order to analyze your web site and create reports. Every time
the visitors come to your site and click on the links web server writes these actions to the log file. Log file
contains records about all web pages and graphic elements requested by the users. Log files are usually stored
on the web server computer. You need to ask you ISP or hosting company how to get the raw log files for your
website. On Unix hosting log files usually have names similar to access_log or access_log.gz. On Winsows/IIS
hosting files usually are named like ex040423.log, ex040424.log.
This software can not analyze log files from other programs, like proxy server logs, etc. Deep Log Analyzer can
access log files via ftp or read logs from your local drive if you have copied them from the web server
computer. Deep Log Analyzer can read log files archived in zip or gz.

Where is the projects data actually stored on my hard drive?

I want to back it up/I want to move it to another folder or drive. Deep Log Analyzer keeps files for all projects
inside one single directory. Exact location varies from computer to computer and usually is "C:\Documents and
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Settings\All Users.WINDOWS\Application Data\DLA Storage\". To see where the Data Storage is located on your
computer click File-Open menu and look at the bottom of the Open Project dialog. Projects are located in
subfolders inside Data Storage directory. Each project folder contains hits.mdb file that is MS Access database
containing imported log files.
If it is not enough free space on the hard drive with the storage you may move it to another drive. Click File-
Move Data Storage menu to do it. Deep Log Analyzer will copy all files to the new location you entered.

For more information please read this topic: Data Storage

What kind of database does Deep Log Analyzer use?

Deep Log Analyzer imports web server log files into industry standard MS Access database. There is one
separate mdb file for each project. Database file is named hits.mdb and located in project's subdirectory inside
Data Storage.
You can simply open database in MS Access using [File-Open Database in MS Access] menu command.
Database is carefully designed according to normalization rules for speed- and size- efficient storage of web
site log files data. To view database structure diagram click open diagram.jpg file located in Deep Log Analyzer
directory or click View Database Diagram in Start menu. You can design custom query in MS Access and create
custom report in the program based on that query.
Standard database format makes it easy to open the database in other programs where you need to access
website statistical data.
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8 Working With Reports

8.1 Reports Overview

Report Area - Displays the results of the generated report. There are two types of reports in Deep Log
Analyzer that can be open in report area:

· General Statistics - HTML based report that shows key statistics providing an immediate
snapshot of website activity.

· Table and chart report that shows numerical statics data followed by a graphical chart for best visual
perception of the provided information.

Table and chart areas are divided by the movable splitter with buttons to customize how you view the data.
For example:

o To maximize the tables that contain the numeric data, click .

o To maximize the graphical chart part, click .

o To restore the display to its previous look, click .

What you can do with the reports

Report tabs:

· Open multiple reports on separate tabs. Right Click on the report in list and click Open in New Window
or click on the report in list while holding Shift key

· Quickly switch from one report to another by clicking on the report's tab. Press Ctrl+F6 or Ctrl+Tab to
switch to the next report.

· Sort report by any column. Click on the column header to sort in ascending order, click once again to
sort in descending order. Hold down Shift key while clicking to sort by multiple columns. You can sort
separately records on each level. Sorting order is stored when you close and reopen the report. Sorting
is reset when you close the project.

· Click  button to open all levels of the reports. Click  button to close all open
levels of the report and show only the upper level. Lower levels usually show some kind of the
information logically relative to the expanded record of the upper level. Click + or - signs to expand/
collapse individual reports. This only applies to multi-level reports. There can be up to 3 levels in Deep
Log Analyzer standard reports. Each level is color-marked differently.

· Click on the another level or move table cursor of in the table to view that part on graphical chart.
· Export report to HTML for easy emailing, sharing with colleagues, publishing on the website or storing

for historical comparison. Click  button in toolbar to export active report.
· Print Preview and Print the report
· Choosing another date range in calendar immediately updates report on the active tab accordingly.

Read more about Filtering Reports by Date
· Compare same report for different date ranges. Open two instances of the report on separate tabs and

choose different date ranges in calendar for each tab. Switch between tabs to compare reports visually.
Read more about Filtering Reports by Date

· Click on the URLs in the reports to open them in your web browser. Only cells with "hand" mouse
pointer are clickable.

· View report in full screen mode. Clicking  button in toolbar (F11) hides all panes and maximizes
report area to occupy all screen space. Click Close Full Screen button to restore normal view mode.
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8.2 Viewing Report Properties

Structured Query Language. A language used by relational databases to query, update, and manage data.

A report's properties allow you to see what SQL queries are used to generate the report. For predefined
reports you can only view the SQL queries, but with custom reports you can also change the SQL queries. The
report's properties are displayed in the Report Properties window.

To view a report's properties:

1. In the Reports pane, click the name of the report. The report opens in the Report window.
2. In the Reports section of the Tasks pane, click View Report Properties.

- OR -

Right-click the report name and choose Properties from the shortcut menu.

8.3 Custom Reports

8.3.1 Creating Custom Reports

Structured Query Language. A language used by relational databases to query, update, and manage data.
The organization of information within a database. The schema consists of table, field, and index definitions.

Although Deep Log Analyzer comes with a substantial number of predefined reports that cover many areas of
website analysis, it also provides you with the option to design your own reports using SQL.

It is possible to create reports on any aspect of website usage because all of the data from the log files is
imported into a relational database of industry standard MS Access format . You may create new reports based
on any predefined report. You can create new reports using the predefined report's SQL query, and then you
edit the SQL to create a custom report. Or you may create new custom report from scratch.

Tip:  Deep Log Analyzer comes equipped with an SQL query editor that includes advanced syntax
highlighting for convenient editing of SQL query.

To design good and useful reports you:
· Must become familiar with Deep Log Analyzer's database structure. You can view the database schema

by clicking Start, pointing to All Programs, pointing to Deep Log Analyzer, and clicking View
Database diagram.

· Must be familiar with basics of relational databases and SQL language. You may want to visit the
following websites for help building your SQL queries:
o http://www.w3schools.com/sql/default.asp

o http://www.microsoft.com/office/access

o http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/

Q189/6/57.ASP&NoWebContent=1
o http://www.google.com/search?q=sql

Tip:  Use Microsoft Access' query designer to more easily create custom report queries.
a. Open your project's database in Microsoft Access. Click Tools-Open Database in MS Access menu

Tip:  Your project's database can usually be found in the following location:
C:\Documents and Settings\All Users\Application Data\DLA Storage\Project
Name\hits.mdb

b. Create and design new query. Use the online help in Access for assistance.
c. Copy the text of the SQL query into the custom report in Deep Log Analyzer (step 5 below).

- Or -

d. Save the query in Microsoft Access and enter the following SQL query in Deep Log Analyzer (step 5
below):

SELECT * FROM [Access Query Name]

· Can contact us if you require additional assistance designing a custom report.

To create a custom report:

http://www.w3schools.com/sql/default.asp
http://www.microsoft.com/office/access
http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/Q189/6/57.ASP&NoWebContent=1
http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/Q189/6/57.ASP&NoWebContent=1
http://www.google.com/search?q=sql
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1. Right-click the Custom Reports folder, which can be found at the bottom of the Reports pane report
hierarchy, and select Create from the shortcut menu.

The New Report Wizard opens.

2. From the reports list, choose a report on which you'd like to base the custom report, or, if you'd like to
start from scratch and build a completely new custom report, choose <none>.

3. Click Next.
4. Change the name of the report to something more meaningful.

For example, if you are creating a custom version of the Browsers report that does not include the
browser's version, you could change the report's name to Browsers - No version.

5. Update or create the SQL query.
6. Click Finish.

Note:  SQL syntax errors may be identified by Deep Log Analyzer and an error message displays
helping you determine where the error occurs.

8.3.2 Saving Custom Reports

Once you have created a custom report, you can save (or export) the report's settings. You may then add the
report to another project or move the report to another computer (Read Loading Custom Reports). The
report's settings are saved to a .dxr file.

To save a custom report:
1. From the Reports section of the Tasks pane, click Save Custom Reports As. The Select Reports

dialog box opens.

2. From the Available Reports list, choose the report you wish to save, and then click .

Tip:  To remove a report from the Reports to be Saved list, select it and click .
3. Click Next. The Select Reports File dialog box opens.
4. Click Browse. The Save As dialog box opens.
5. Browse to where you want to save your file, type a name for the exported custom report, and click 

Save. The Save As dialog box closes and the Select Reports File dialog box displays the path and file
name of the exported report in the Reports File field.

6. Click Finish.

8.3.3 Loading Custom Reports

Once you have saved a custom report, you can load (or import) the report's settings. The report's settings are
saved to a .dxr file, therefore you will be loading the report settings from a .dxr file. Loaded reports appear

in Custom Reports group in Reports Pane. Click on the newly added report to execute it and view the results.

To load a custom report:
1. From the Reports section of the Tasks pane, click Load Custom Reports. The Open dialog box opens
2. Browse for the .dxr file that contains the report settings.

3. Click Open. The report is added to the Custom Reports folder, which is found at the bottom of the
Reports pane report hierarchy.
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Once the report has been loaded, you can click it to view the output.

8.4 Exporting Reports

Export a single report 

You can export all standard and custom reports to HMTL for easy emailing, sharing with colleagues, web
publishing or storing for historical comparison. To export an individual report to HTML:

1. Click the name of the report that you wish to export.
2. From the Report menu, choose Export to HMTL.
3. Navigate to where you want to save the .html file.
4. Click Save.

Export List

Deep Log Analyzer also provides Export List feature that allows you to export multiple reports to a single
framed HTML complex report. This complex format allows to navigate between exported group of reports in
web browser. Export List is useful for easy publishing reports on the websites. This kind of export generates
multiple HTML and .gif files in the directory you specify.

Export List can also be run automatically on schedule.

To export list of reports to HTML:
1. Click Tools - Export List menu. Export Reports List  Window will open
2. Mark the check boxes near reports you want you want to include into export
3. Navigate to where you want to save the .html files.
4. You can save selected reports list and export path to an Export List Profile on top of the window. Click

Save button. Later you can select this profile from the list.
5. Click Export to start exporting reports.

Export chart

For the reports that contain graphical chart, you can export the graph as an image in .png format. To export a
report's graph:

1. Click the name of the report that contains the graph that you wish to export.

2. Click the arrows  to expand the menu to show all commands. Click Export Chart. 
· or right click on the chart in a report window and click Save to File 
· or press Alt+C

3. The Save As dialog box opens.
4. Navigate to where you want to save the file.
5. Click Save.
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9 Advanced Topics

9.1 DeepTracker Setup

Deep Log Analyzer uses DeepTracker technology for the best measurement accuracy of unique website
visitors, sessions, returning visitors and other valuable website metrics.

Advantages of DeepTracker technology

ü Uniquely identifies each session using session cookies

ü Identifies sessions correctly when user's IP changes during the session

ü Identifies visitors uniquely by permanent cookie 

ü Allows to detect returning visitors metrics accurately

ü Overcomes proxying

ü Overcomes caching by browsers and ISPs

ü Records extended information about visitors systems such as:

· screen resolution;

· color depth;

· Javascript support;

· Flash version;

· system language;

ü Records exact visitor's path

Installation

DeepTracker technology is easy to install and use in Deep Log Analyzer.

1.Enable DeepTracker method for your project

Open Project Settings in Deep Log Analyzer and go to Analysis tab. Mark "DeepTracker method" radio button
in Session & Visitor Tracking section of the window

2.Upload tracking files to the website

You need to place dla_tracker.js and dla_tracker.gif files on your website. These files can be found in
"{Program Files}\Deep Log Analyzer\DeepTracker\" folder. Upload them to them to the main directory of your
website. 

If site's page files are located in sub-directories of the website as well, you need to upload dla_tracker.js and
dla_tracker.gif files into all  such subdirectories too.

3.Add DeepTracker Code to web pages

DeepTracker Code is a small part of HMTL code that looks like this:

<!--Deep Log Analyzer DeepTracker code Start. Do not modify this code-->
<script src="dla_tracker.js" type="text/javascript"></script>
<script type="text/javascript">
   dtDoTrack();
</script>
<noscript>
   <a href="http://www.deep-software.com/" target="_blank"> 
     <img src="dla_tracker.gif?_dtjava=false" alt="website statistics" border=0>
   </a>
</noscript>
<!--Deep Log Analyzer DeepTracker code End-->
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You need to get the code specific for your website. Open DeepTracker Code page in Project Settings. Click
Copy to Clipboard button. Then open the editor you use to edit the website and paste this code right below
<body> tag. This code should be inserted in all pages of the website. If your website design uses includes for
displaying header on each page, it is the best place to insert the DeepTracker Code.

Tip: If it is impossible to insert DeepTracker Code in ALL pages of the website try to insert it at least in
the main page and possible landing pages (entry pages) of the website.

4.Check DeepTracker Code

Open Project Settings->DeepTracker code tab an Click Check DeeptTracker code button or click File->Check
DeepTracker Status menu. This will verify if DeepTracker Code is correctly installed on the website. 

Deep Log Analyzer will check for DeepTracker Code in the HTML code of site's main page and presence of 
dla_tracker.js and dla_tracker.gif files in website's root folder. Deep Log Analyzer will report if any problem
found. Fix possible problem and click Check DeepTracker code button again to make sure that tracking is set
up correctly. Then move on to the next step.

5.Enabling cookies recording in web server

This step is required to ensure that your web server records cookies information in the web log files. Deep Log
Analyzer needs this information in logs to process data recorded by DeepTracker technology installed on the
website. This is done differently on Apache (Unix hosting) and IIS (Windows hosting). Follow these instructions
for your web server:

· Apache web server - setup log files

· Microsoft IIS Server - setup log files

6.Import log files

Import log files created after adding cookie field. Check Screen Resolution report. If it's not empty,
DeepTracker technology is setup and functioning properly

9.2 Logging setup in Apache

Apache Web Server

Deep Log Analyzer supports CLF log files created by Apache web server. If you use DeepTracker method for
session tracking, you need to enable Cookie field in Apache logs. Follow these instructions to change logs
format in Apache web server:

1.Open APACHE_HOME/conf/http.conf file (APACHE_HOME represents the Apache install directory) on the
webs server computer in a text editor of your choice. Normally it should have the line similar to the one
below. Find it:

LogFormat "%h %l %u %t \"%r\" %>s %b \"%{Referer}i\" \"%{User-Agent}i\"" combined

2.Copy it to the line below and add {Cookie} field at the end. Assign this format specification a different
name:

LogFormat "%h %l %u %t \"%r\" %>s %b \"%{Referer}i\" \"%{User-Agent}i\" \"%{Cookie}i\"" combined_cookies

3.Then modify CustomLog like line to use newly specified log format:

CustomLog logs_path/access.log combined_cookies

4.Save modified http.conf file

5.Verify http.conf syntax

For Unix/Linux based systems

APACHE_HOME/bin/apachectl configtest

For Windows

APACHE_HOME/bin/apache -t

This should pass without any errors.
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6.Restart Apache web server. Run this command from command prompt

For Unix/Linux based systems

APACHE_HOME/bin/apachectl restart

For Windows. Open Services in Control  Panel and Restart Apache service or issue following commands:

net stop apache2
net start apache2

7.Check log file format. Open web browser, visit the website and make a few clicks. Open logs_path/access.
log file. Look at a few last lines of the log file. They should contain DeepTracker cookie
at the end like in this sample:

192.168.1.101 - - [18/Dec/2006:11:51:31 -0800] "GET /buglist.html HTTP/1.1" 200 5485 "-"
"Mozilla/5.0 (Windows; U; Windows NT 5.1; en-US; rv:1.8.1) Gecko/20061010 Firefox/2.0"
"__dla_cc=84353-2109416784;__dla_sc=_dt_ss_uid%3D65650-51180020%26_dtscr%3D1680x1050x32%
26_dtlang%3Den-US%26_dtjava%3Dtrue%26_dtflash%3D9.0%20%20r28"

Notice presence of __dla_cc and __dla_sc cookies created by DeepTracker

Supported formats of Apache log

Deep Log Analyzer supports following formats of Apache log files.

Common log format (CLF) without referrers, user agent, and cookies. Referrals, search engines,
browsers, OSs, etc. reports will be empty.

LogFormat "%h %l %u %t \"%r\" %>s %b" common

Combined log format:

LogFormat "%h %l %u %t \"%r\" %>s %b \"%{Referer}i\" \"%{User-agent}i\"" combined

Combined log format with cookie field. Recommended format that allows to use DeepTracker
technology and allows to create a full set of reports

LogFormat "%h %l %u %t \"%r\" %>s %b \"%{Referer}i\" \"%{User-Agent}i\" \"%{Cookie}i\"" combined_cookies

Deep Log Analyzer also supports virtual host field (%v) in log files. It's used when you run a server with many
virtual hosts, that use the same log file. Virtual host field should always be first:

LogFormat "%v %h %l %u %t \"%r\" %>s %b \"%{Referer}i\" \"%{User-Agent}i\" \"%{Cookie}i\"" combined_cookies

9.3 Logging setup in IIS

Microsoft IIS Server

Deep Log Analyzer supports W3C log files created by MS IIS (Microsoft Internet Information Services) web
server. If you use DeepTracker method for session tracking, you need to enable Cookie field in IIS logs. Follow
these instructions to setup format of log file created by in IIS web server. 

1.Open Internet Information Services (IIS) Manager from Start menu->Control Panel->Administrative Tools

2.Right Click on the website and click Properties. go to Web Site tab, select Active Log Format: W3C Extended
Log File Format. Click Properties
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3.In Logging Properties Window go to Advanced tab. Mark at least the fields listed below. Make sure Cookie is
marked if you use DeepTracker session tracking method in Deep Log Analyzer. If you have more fields
selected, it does not cause any problems with Deep Log Analyzer.

These fields in W3C file are required for best
reporting:

· Date (date)

· Time (time)

· Client IP Address (c-ip)

· User Name (cs-username)

· Server Port(s-port)

· Method (cs-method)

· URI Stem (cs-uri-stem)

· URI Quesry (cs-uri-query)

· Protocol Status (sc-status)

· Bytes Sent (sc-bytes)

· Time Taken (time-taken)

· Host (cs-host)

· User Agent (cs(User-Agent))

· Cookie (cs(Cookie)) - required only if
DeepTracker method is selected in Deep
Log Analyzer

· Referer (cs(Referer))

4.Check log file format. Open web browser, visit the website and make a few clicks. IIS usually keeps its log
files in this folder: C:\WINDOWS\system32\LogFiles. Open last .log file. Look at a few last lines of the log
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file. They should contain DeepTracker cookie at the end like in this sample and all other fields:

2006-12-01 00:05:50 W3SVC4045 C27384-57916 70.87.39.67 GET /images/clients.swf - 80 -
128.125.97.224 HTTP/1.1 Mozilla/4.0+(compatible;+MSIE+6.0;+Windows+NT+5.1;+SV1;+.NET+CLR
+1.1.4322) __dla_cc=29658-2077989892;+__dla_sc=_dt_ss_uid%3D9215-1474221040%26_dtscr%
3D1280x1024x32%26_dtlang%3Den-us%26_dtjava%3Dtrue%26_dtflash%3D8.0 - www.deep-software.com 304
0 0 212 575 46

Notice presence of __dla_cc and __dla_sc cookies created by DeepTracker

9.4 Data Storage

I want to back it up/I want to move it to another folder or drive. Deep Log Analyzer keeps files for all projects
inside one single directory. Exact location varies from computer to computer and usually is "C:\Documents and

Settings\All Users\Application Data\DLA Storage\". To see where the Data Storage is located on your
computer click File-Open menu and look at the bottom of the Open Project dialog. Projects are located in
subfolders inside Data Storage directory. Each project folder contains hits.mdb file that is MS Access database
containing imported log files.

If it is not enough free space on the hard drive with the storage you may move it to another drive. Click File-
Move Data Storage menu to do it. Deep Log Analyzer will copy all files to the new location you entered.

9.5 Deep Log Analyzer Options

Click Tools->Options menu in Deep Log Analyzer to open Options Window:

Right click on any field in this window and click What's This? to read about it
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9.6 Search Engine Definitions

A website that enables users to locate information on the World Wide Web. Search engines use keywords
entered by users to find Web sites which contain the information sought

Deep Log Analyzer currently can recognize more than hundred most popular internet search engines, such as
Google, Yahoo, MSN, etc. It can find in log file a search engine's name and key phrase that referred visitor to
your website. If you receive hits from some local search sites, that Deep Log Analyzer does not recognize in
standard configuration, you can add them to search engine definitions in search_engines.ini file located in
Deep Log Analyzer folder (by default it's C:\Program Files\Deep Log Analyzer).

Newly added engines and search phrases will appear in all search engine reports in Deep Log Analyzer after
you import (or reimport) log files. Open search_engines.ini file in Notepad, add new line in the format like 
SE114=MySearchEngine into [SearchEngines] section. Than add new [MySearchEngine] section at the end of file and
list the values that tell how to recognize hit from this search engine:

EngineIndicator1=mysearchengine.com
EngineIndicator2=mysearchengine.net
SearchPhraseIndicator1=?q=
SearchPhraseIndicator2=&q=

After these changes DLA will recognize referral URL like http://www.mysearchengine.com?q=phrase1 as a hit from
MySearchEngine search engine with search keyword "phrase1".

Search engine definitions are processed at the time of log file parsing, so the newly added definitions will work
only for logs that you import later on. You may re-import log files to apply changes to all imported data. It is
recommended to back up your edited .ini file or it will be overwritten when you reinstall the program. Or just
keep a copy of added records in a separate file.

Requests for files from visitors. Each HTML document and graphic file counts as a separate hit, so hits are not
always an accurate representation of the number of different visitors to your site. Hits are also referred to as
requests.
A website that enables users to locate information on the World Wide Web. Search engines use keywords
entered by users to find Web sites which contain the information sought
A referral occurs when any hyperlink is clicked on that takes a web surfer to any page or file in another
website; it could be text, an image, or any other type of link. When a web surfer arrives at your site from
another site, the server records the referral information in the hit log for every file requested by that surfer. If
a search engine was used to obtain the link, the search engine name and any keywords used are recorded as
well.

9.7 Browser, Spider and OS Definitions

Automated program that "crawls" the Web, generally for the purpose of indexing web pages for use by search
engines. Because most web pages contain links to other pages, a spider can start almost anywhere. As soon
as it sees a link to another page, it goes off and fetches it. Large search engines have many spiders working in
parallel.

Deep Log Analyzer can recognize most of modern browsers, operating systems and search engine spiders.

But you can add custom browser, search engine spider and OS definitions in user_agents.ini file. Look at
Unrecognized Browsers report. It shows all User Agent fields found in imported log files that are not described
properly in user_agents.ini. If you get lots of hits from some kind of user agent (for example new download
manager) that Deep Log Analyzer does not recognize, you can add custom definition for this user agent. It will
be then recognized as a standard browser and will appear in all browser-related reports. Definitions should be
entered in the following format in [Browsers] section:

BROWSERXX=[Name],[Log file stamp used to find it]
For example: BROWSER22=ReGet(downloader),ReGet

 

The same format is used for search engine robots  (search spiders). Add records to [Spiders] section on
user_agents.ini file in the following format:

SPIDERXX=[Name],[Log file stamp used to find it]
For example: SPIDER1=AltaVista,vscooter
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You may also add new Operating System definitions to [Platforms] section in user_agents.ini in the following
format:

PLATFORMXX = [Name],[Log file stamp used to find it]
PLATFORM1 = Windows XP,Windows NT 5.1

 
Notes

- Make sure that browsers, spiders and OSs numbering in their respective sections are continuous with no
gaps

- Log file stamp is checked for match against user agent filed in the log file

- Do not change the order of the standard definitions provided with the program

- Back up edited ini-file as it can be overwritten when you install new version of Deep Log Analyzer

 

Automated program that "crawls" the Web, generally for the purpose of indexing web pages for use by search
engines. Because most web pages contain links to other pages, a spider can start almost anywhere. As soon
as it sees a link to another page, it goes off and fetches it. Large search engines have many spiders working in
parallel.
A website that enables users to locate information on the World Wide Web. Search engines use keywords
entered by users to find Web sites which contain the information sought
Requests for files from visitors. Each HTML document and graphic file counts as a separate hit, so hits are not
always an accurate representation of the number of different visitors to your site. Hits are also referred to as
requests.
Fields in an extended web server log file identifying the browser and platform used by a visitor. This includes
graphical browsers, text-only browsers and non-visual browsers such as audio or braille browsers, search
engine robots.
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10 Standard Reports

10.1 General Statistics Report

General Statistics Report

This report shows your website's key statistics providing an immediate snapshot of website activity. This
overview report is the starting point of the website analysis. Click this icon  to open related detailed report in
new report tab.

This report shows statistics for the dates interval currently selected in calendar.

10.2 Accessed Resources

10.2.1 Top Pages Report

Top Pages Report

This report shows the popularity of the web pages on your website. Pages are ranked by the number of times
the page was requested by the visitors (number of hits ). Deep Log Analyzer considers request to only files
with specific extensions as pageviews. These extensions include html, htm, asp, aspx, php, and others. CSS
stylesheets, javascript files, graphics (gif, jpg, etc.), sound (wav, mp3,...), video (avi, mpg,...) files are not
considered as pages and are  not shown in this report. Data Transferred column shows how many total Kb
were transferred  by the web server to the visitors for each viewed page.

Click Expand button in toolbar or + signs to view second level of the report.  Second level shows the list of 
referrers that lead visitors to this page. Referring ULRs are ranked by the number of referrals (shown Number
of Hits column). If referrer is a search engine recognized by Deep Log Analyzer that row also includes search
engine name and search phrase used to find your website's page. NO REFERRAL row means that the file was
requested directly by typing URL in the browser or by referral from another page on your website (in case if
Remove Self Referrals option is on in Project Settings)

Benefits

- See whether most visitors view important website content. If not, you may need to restructure or change
pages layout on your website to 

ensure that this critical information can be easily located.

Notes

- This report includes both successful and error hits

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table. 

Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

- Page names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.
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10.2.2 All Accessed Files Report

All Accessed Files Report

This report shows the popularity of the all files located on your website including web pages, graphics, media
and other files. Files are ranked by the number of times they were requested by the visitors (number of hits ).
This report includes files with all extensions.

Data Transferred column shows how many total Kb were transferred  by the web server to the visitors for each
requested file

Notes

- This report includes both successful and error hits

- File names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.

10.2.3 Top Downloads Report

Top Downloads Report

This report shows the popularity of the files downloaded from on your website. Downloads are ranked by the
number of times files were requested by the visitors (number of hits ). Deep Log Analyzer considers request to
only files with specific extensions as downloads. These extensions include zip, exe, rar, tar, etc. Web pages
(html, asp, php, etc.), graphics (gif, jpg, etc.), sound (wav, mp3,...), video (avi, mpg,...) files are not
considered as downloads and are not shown in this report.

Data Transferred column shows how many total Kb were transferred  by the web server to the visitors for each
downloaded file

Notes

- This report includes both successful and error hits

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

- This reports may show more hits than the number of times file was actually downloaded. This may be caused
by the following facts. Many people use download manager programs for downloading large files from the
Internet. These programs may split files into sections and download them separately. This results in multiple
requests to the same file recorded in the web server log with Partial Content status code (206) and increase
the number of hits displayed respectively.
Also visitors may cancel download process before end resulting in the hit recorded in log file not corresponding
to the actual complete file download.

To track actual number of downloads of some important files get additional custom reports available on Deep
Software website here: http://deep-software.com/morereports.asp

http://deep-software.com/morereports.asp?ref=dla
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10.2.4 Accessed Graphics Report

Accessed Graphics Report

This report shows the popularity of the graphic files viewed by the visitors on your website. Graphic files are
ranked by the number of times they were requested by the visitors (number of hits ). Deep Log Analyzer
considers only files with specific extensions as graphic files. These extensions include gif, jpg, bmp, ico, png,
etc. Web pages (html, asp, php, etc.), sound (wav, mp3,...), video (avi, mpg,...) files are not considered as
graphics and therefore are not shown in this report.

Data Transferred column shows how many total Kb were transferred  by the web server to the visitors for each
graphic file

Warning: This report may contain no rows (be empty) with the default Project Settings. This is
because by default it does not import hits on graphic files. If you need to see this report
open Project Settings, switch to Excludes tab and unmark Do Not Import Hits on Graphic
File check box. Then reimport your log files into the DLA project. This will result in much
larger database size and slower import and reports as hits on graphics usually take a
considerable portion of all hits in the log file.

Notes

- This report includes both successful and error hits

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

10.2.5 Entry Pages Report

Entry Pages Report

This report shows the popularity of web pages site visitors use to enter the website. Entry page is the first web
page requested by the visitor during his visit. Number of Hits column shows the number of times visitors
entered the website through the particular page.

Deep Log Analyzer considers only files with specific extensions as pages. 

These extensions include html, htm, asp, aspx, php, and others. CSS stylesheets, javascript files, graphics (gif,
jpg, etc.), sound (wav, mp3,...), video (avi, mpg,...) files are not considered as pages and are  not shown in
this report.

Notes

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

10.2.6 Visitors Bouncing Rate

Visitors Bouncing Rate

This report is important for Internet marketers, as it's a good for them to design the strategies to reduce the
bouncing rate for the key web pages to the minimal level. When website has an acceptable low bouncing rate
you can concentrate on increasing the purchase rate.

Benefits

- Bouncing rate report helps to identify the efficiency of design, layout, copywriting of the different important
pages on the website such as home page and e-commerce campaigns landing pages. Create unique URL
parameters or landing pages for the advertising campaigns and track each of them separately in this report
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- Find out if you attract the right audience to the website. If your visitors are interested in the website content
they browse deeper into the site and show lower bouncing rate.

Columns:
Entry page - page name used by the visitors to enter the site
Entries - number of times visitors entered the website trough the web page, first requested page in the visit
Bounced - number of times visitors left the website without viewing any more pages , i.e. did not request more
pages from the web server
% Bounced - percentage of visits that where bounced from this page, i.e. Bounced/Entries*100%

Notes

- This report includes only successful pageviews and does not take into account error page requests, such as
not found pages (resulting in Error 404)

- Take into account that this report is based on number of visits and not on the number of unique visitors.
Same visitor may come to site many times, i.e. have many visits recognized by the program

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

- Page names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.

10.2.7 Exit Pages Report

Exit Pages Report

This report shows the popularity of web pages on which visitors exit the website. Exit page is the last web
page requested by the visitor during his visit. User exits website when he closes his browser window, clicks on
the external link or directly enters the URL in the address field and goes to another site. Number of Hits
column shows the number of times visitors exited the website through the particular page.

Deep Log Analyzer considers only files with specific extensions as pages. These extensions include html, htm,
asp, aspx, php, and others. CSS stylesheets, javascript files, graphics (gif, jpg, etc.), sound (wav, mp3,...),
video (avi, mpg,...) files are not considered as pages and are  not shown in this report.

Notes

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

10.2.8 Entry Files Report

Entry Files Report

This report shows the popularity of files visitors use to enter the website. Entry file is the first file requested by
the visitor during his visit. Number of Hits column shows the number of times visitors entered the website
through the particular file. This report is similar to Entry Pages Report but it includes all files such as graphics
and downloads and not only web pages.
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10.2.9 Single Access Pages Report

Single Access Pages Report

This report shows the web pages ranked on the number of times this page was the only one requested during
a visit. As a user arrives to the website and leaves it without going deeper the second column in this report is
incremented. This column is identical to Bounced column in Visitors Bouncing Rate report. Optimize your pages
to reduce this number

Notes

- This report includes only successful pageviews and does not take into account error page requests, such as
not found pages (resulting in Error 404)

- Take into account that this report is based on number of visits and not on the number of unique visitors.
Same visitor may come to site many times, i.e. have many visits recognized by the program

- You may configure the file extensions list by which Deep Log Analyzer 

recognizes files as pages, downloads and graphics. To do this open config.mdb file located in DLA's folder in
MS Access and edit FileExtension table. Add, remove file extensions or change the type of the extension. It is
recommended to reimport (delete from database and import again) log files into the project after editing file
type definitions in order to have the changes reflected in the reports.

- Page names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.

10.2.10 Directories Report

Directories Report

This report shows the popularity of the web site directories (folders). The report is ranked by the number of
times (Hits ) visitors requested web pages or any files located in that directory.

Directory name does not include website domain name. To get a full url of the directory add your website
domain name at the beginning. For example, /images/ directory means htp://www.site.com/images/. Data
Transferred column shows the total number of Kb transferred  by the web server to visitors from the
directories.

Benefits

- Find out what logical parts or topics of your website are popular, as websites are usually grouped by folders
logically.

Notes

- This report includes both successful and error hits

- / directory means the website's root directory. It includes, for example, requests to files such as htp://www.
site.com/index.htm, htp://www.site.com/page1.htm, etc.

Requests for files from visitors. Each HTML document and graphic file counts as a separate hit, so hits are not
always an accurate representation of the number of different visitors to your site. Hits are also referred to as
requests.

10.2.11 Top Level Directories Report

Top Level Directories Report



Standard Reports 63

© 2006 Deep Software Inc.

This report shows the popularity of the web site top level directories (folders). The report is ranked by the
number of times (Hits ) visitors requested web pages or any files located in that top level directory and all its
subdirectories. For example, all hits on files in such folders as \pages\topic1\, \pages\topic1\subtopic\, \pages
\topic2\ will be grouped and displayed in this report as hits on top level \pages\ directory.

Directory name does not include website domain name. To get a full url of the directory add your website
domain name at the beginning. For example, /images/ directory means htp://www.site.com/images/. Data
Transferred column shows the total number of Kb transferred  by the web server to visitors from the
directories.

Benefits

- Find out what logical parts or topics of your website are popular, as websites are usually grouped by folders
logically.

Notes

- This report includes both successful and error hits

- / directory means the website's root directory. It includes, for example, requests to files such as htp://www.
site.com/index.htm, htp://www.site.com/page1.htm, etc.

Requests for files from visitors. Each HTML document and graphic file counts as a separate hit, so hits are not
always an accurate representation of the number of different visitors to your site. Hits are also referred to as
requests.

10.3 Site Navigation

10.3.1 Popular Paths through Site

Popular Paths through Site

This report shows the popularity of paths traveled by website's visitors starting with their Entry Page and to
their Exit Page. Each row lists one or more pages in the order they were viewed separated by dash symbols.
Each user visit has its own path. These paths are grouped and the number of visits with such path is shown in
the respectable column.

Notes

- This report shows only to top 1000 of all available paths. To see more records create a custom report based
on this report and remove TOP 1000 from its SQL query. Maximum total length of path is 255 characters

- This report includes only successful pageviews and does not take into account error page requests, such as
not found pages (resulting in Error 404)

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

- Page names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.

10.3.2 Came From Page

Came From Page

This navigation report shows how visitors reach particular pages on your website. First level of the report
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shows web pages ranked by the number of pageviews. Click Expand button in toolbar or + sign to view second
and third levels of the report. Second level contains the web pages from which visitors surfed to the expanded
page on first level ranked by number of times they did it. In other words, page on the second level of the
report was requested right before the page on the first level. EXTERNAL line on the second level shows the
number times visitors came to this page from external site or by direct request in browser. Expand 3rd level
under EXTERNAL to view a list of external referrals to this page raked by the number of hits

Benefits

- Find out how visitors reach goal web pages on your website. View what pages are most effective at driving
visitors to your buy, subscription, download or other key pages.
- Analyze users behaviour on the website

Notes

- This report includes only successful pageviews and does not take into account error page requests, such as
not found pages (resulting in Error 404)

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table. 

Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

- Page names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.

10.3.3 Left To Page

Left To Page

This navigation report shows to what destination URLs visitors leave particular pages on your website or what
links they click on web pages. First level of the report shows all web pages ranked by the number of 
pageviews. Click Expand button in toolbar or + sign to view seconds level of the report. Second level contains
the web pages to which visitors surfed after the page expanded on first level ranked by number of times they
did it. In other words, page on the second level of the report was requested right after the page on the first
level. EXITED SITE line on the second level shows the number times visitors left the site after viewing the web
page.

Benefits

- Find out how visitors reach goal web pages on your website. View what pages are most effective at driving
visitors to your buy, subscription, download or other key pages.

Notes

- This report includes only successful page views and does not take into account error page requests, such as
not found pages (resulting in Error 404)

- You may configure the file extensions list by which Deep Log Analyzer recognizes files as pages, downloads
and graphics. To do this open config.mdb file located in DLA's folder in MS Access and edit FileExtension table.
Add, remove file extensions or change the type of the extension. It is recommended to reimport (delete from
database and import again) log files into the project after editing file type definitions in order to have the
changes reflected in the reports.

- Page names in this report may include URL parameters as specified on Dynamic Content tab in Project
Settings window. If Retain URL Parameters option is marked on Deep Log Analyzer will show requests to the
same page with different parameters as requests to the different pages and put them in separate rows in this
report.
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For example, the following requests will be shown in separate rows: default.asp,  default.asp?ref=ad1, 
default.asp?ref=ad2
You should also turn on Retain URL Parameters option if your website's pages content is dynamic (database
driven sites) and is controlled by URL parameter(s), for example: article.cgi?articleid=1000; article.cgi?
articleid=10123; article.cgi?articleid=1452. In this case you should specify in Project Settings to retain only
articleid parameter as it controls what is actually displayed on the web page.

10.4 Visitors Activity

10.4.1 Top Visitors Report

Top Visitors Report
This report shows the website visitors ranked by the number of visits. Visitor column shows user's IP address
or host name, whatever is presented in the web server's log file. User's country is shown in a separate column.

Click Expand button in toolbar or + sign to view second level of the report. It shows user's operating system
and browser. Take into account, that user may visit your website several times with different browsers. In this
case there will be a separate record for each browser of this user along with the number of visits for each
browser. Automated search robots/spiders visited website are identified by the spider name in Browser/Search
Spider column.

Benefits

- See the most active visitors on your website and how often they return
- Find out if you attract right visitors to the website based on their geographical location
 

Note

- This report shows only to top 1000 of all visitors as their actual number can be very large. To see more
records create a custom report based on this report and remove TOP 1000 from its SQL query or change the
number.

- User's country is determined by Deep Log Analyzer using IP-To-Country database. This is fast and reliable
method that does not require reverse DNS lookups.

10.4.2 Visits History Report

Visits History Report

This report shows the number of visits per day.

Benefits

- Find out how your website's traffic changes over time
 

Note

- This report is different from Hits History report. Each visit consists of one or more hits. This report is more
accurate in showing the trend of your website popularity.

10.4.3 Hits History Report

Hits History Report

This report shows the number of hits per day. Data Transferred column show the total amount of data in Kb
transferred by the web server to site visitors during each day.

Benefits

- Find out how your server load changes over time
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Note

- This report is different from Visits History report. Each visit consists of one or more hits. This report is more
accurate in showing the trend of workload on your web server.

10.4.4 Visitors Stay Length Report

Visitors Stay Length Report

This report shows how long visitors remain on your website. Visit Duration column shows the average length of
visit. Number of Visits column shows the total number of visits with such length. Assess this information in
light of your site content. Program considers that visit continues as long as web server receives hits from that
visitor with time intervals no more than Visit Timeout value, specified in settings. As soon as <Visit Timeout>
time elapsed and no hits received, visit is considered finished.

Note

- This report is affected by the visit timeout value, specified in Project Settings on Site tab

- Visits with only one hit are considered to be 0 seconds long

10.4.5 Depth Of Visit Report

Depth Of Visit Report

Shows how many pages users view in one visit when browsing your website. First column shows the number
of pages seen and the second column shows the number of visits with such number of page views.

Benefits

- This report shows depth of site exploration, how engaged visitors are.

Note

- This report does not include visits by search engine bots

10.4.6 Popular Days of Week Report

Popular Days of Week Report

This report shows how traffic on your website changes depending on the day of week. Number of hits and
Kbytes transferred are grouped by the day of week in this report.

Benefits

- Find out in what days your website gets more traffic generating more server load. Most sites get less traffic
on weekends

Notes

- Week day names and first day of the week (Sunday or Monday) are taken from your local Windows regional
settings. You may change Windows regional settings and reimport logs to change this report.

10.4.7 Visits by Day of Week Report

Visits by Day of the Week Report

This report shows many total visits your website gets in each day of week during all report period.

Benefits

- Find out in what days your website gets more visits. Most sites get less visits on weekends
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Notes

- Week day names and first day of the week (Sunday or Monday) are taken from your local Windows regional
settings. You may change Windows regional settings and reimport logs to change this report.

10.4.8 Popular Hours of Day Report

Popular Hours of the Day Report

This report shows how traffic on your website changes depending on the time of day. Total number of hits and
Kbytes transferred for all report period are grouped by the hours of day in this report.

Benefits

- Find out in what time of day your website gets more traffic generating more server load.

10.4.9 Visits by Hour of Day Report

Visits by Hour of the Day Report

This report shows how number of visits on your website changes depending on the time of day. Total number
of visits for all report period are grouped by the hours of day in this report.

Benefits

- Find out in time of day your website gets more visits.

10.4.10 Authenticated Users Report

Authenticated Users Report

This report shows the User Names that were used during user authentication as required by your site, ranked
by the number of visits. This reports shows information only for secure sites that require user authentication.
Only users authenticated by methods that record the user names in web server log file will be reported, for
example is Apache server '.htaccess' method. Country column shows the user's country

Note

- User's country is determined by Deep Log Analyzer using IP-To-Country database. This is fast and reliable
method that does not require reverse DNS lookups.

10.4.11 Number of Visits per Visitor Report

Number of Visits per Visitor Report

This report shows how many times most visitors visited your website. This illustrates visitors loyalty.

Benefits

- See how loyal your site visitors are

- Find out if your site content makes visitors want to return. Low visitor return values in this report usually
indicate a lack of appropriate site content. However some sites are designed to be viewed only once, other
sites (such as news publications) are designed to be viewed daily. So consider this report in context of your
website destination

10.4.12 Top Countries Report

Top Countries Report
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This report illustrates the countries in which your site visitors are located ranked by number of unique visitors
from that country.

Benefits

- Find out if you're attracting to your web site prospects from the appropriate geographical locations

Note

- User's country is determined by Deep Log Analyzer using IP-To-Country database. This is fast and reliable
method that does not require time consuming reverse DNS lookups.

- Deep Log Analyzer will not be able to determine user's country if the log file contains his domain name
instead of IP address

10.5 Referrals and Search Engines

10.5.1 Referring Sites Report

Referring Sites Report

This report shows the referrer websites that drive visitors to your site ranked by the number of hits received
from that referrer. Referral Site column shows only the top level domain names. Click Expand button in toolbar
or + sign to drill down to the individual pages of the website that have links to your site.

Benefits

- See the traffic sources of your website

- Find out how effective your advertising complains are

- Assess the link popularity of your website

Note

- Click on the referrer URL in the report to open it in your default browser

- This report includes both successful and error hits

10.5.2 Referring Sites History Report

Referring Sites History

This report illustrates how the number of referrals changes over time for each referrer website. Click Expand
All button in toolbar or + sign to view the daily history of hits for individual referrer websites. Upper level of
the reports shows the total number of hits for the referrer, which is the same as in Referring Sites report.

Benefits

- See how the number of clicks on the external links to your website changes over time

- Find out how long the effect of your advertising complains lasts for

Notes

- Click on the expanded second level of the report to see that part of information on the graphical chart. Click
on the upper level to switch graphical chart back to main view

- This report includes both successful and error hits

10.5.3 Referring Pages Report

Referring Pages Report

This report shows the external referrer web pages that bring visitors to your site ranked by the number of hits
received from that referrer. URL column shows the web page address and Number of Hits columns shows the
number of referrals generated by the link on that page.
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Benefits

- See  the traffic sources of your website

- Find out how effective your advertising complains are

- Assess the link popularity of your website

Note

- Click on the referrer URL in the report to open it in your default browser

- This report is different from Referring Sites Report. It shows all individual referral web pages (not sites) on
one level of the report

- This report includes both successful and error hits

10.5.4 Top Search Engines Report

Top Search Engines Report

This report shows a list of search engines used by the visitors to find your website ranked by the number of
referrals (Number of Hits column) from each search engine. Click + sign or Expand button in toolbar to drill
down into the search phrases for each search site. Second level shows the list search phrases and respective
number of hits from each phrase. Open 3rd level of the report to see on what pages users landed on your
website after clicking the link in search results for each phrase.

Deep Log Analyzer recognizes most of the modern search engines. If your website gets hits from some local
search sites that are not recognized by DLA, you can add them to 

Search Engine Definitions. If you do that, referrals from them will also appear in this and other search engines
related reports.

Benefits

- Optimize the website for search engines

- Find out how effective different SEO (search engine optimization) technics are

- See the results of search engine marketing

Notes

- Click on any record in expanded lower level of the report to see that part of information on the graphical
chart. Click on the upper level to switch graphical chart back to main view

- This report includes both successful and error hits

10.5.5 Search Engines History Report

Search Engines History Report

This report illustrates how the number of referrals from each search engine changes over time. Click Expand
All button in toolbar or + sign to view the daily history of hits for individual search engine. Upper level of the
reports shows the total number of hits from each search engine, which is the same as in Top Search Engines
Report.

Deep Log Analyzer recognizes most of the modern search engines. If your website gets hits from some local
search sites that are not recognized by DLA, you can add them to 

Search Engine Definitions. If you do that, referrals from them will also appear in this and other search engines
related reports.

Benefits

- Optimize the website for search engines

- Find out when your website's positions in the search engine result pages (SERP) has been changed on main
search engines
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Notes

- Click on any record in expanded lower level of the report to see that part of information on the graphical
chart. Click on the upper level to switch graphical chart back to main view

- This report includes both successful and error hits

10.5.6 Top Search Sites Report

Top Search Sites Report

This report shows a list of search sites used by the visitors to find your website ranked by the number of
referrals (Number of Hits column) from each search site.  Search site in this report means the domain name of
search engine website. For example, Google has many international domains such as google.com, google.ca
google.co.uk, google.co.jp, etc. All domains, from which some referrals were received, will be listed in this
report in separate rows. First column shows the name of search engine, second column represents search
engine's domain name and third column shows respective number of referrals.

This report is a detailed by domain version of upper level of 

Top Search Engines Report. Deep Log Analyzer recognizes most of the modern search engines and their search
phrases. If your website gets hits from some local search sites that are not recognized by DLA, you can add
them to Search Engine Definitions. If you do that, referrals from them will also appear in this and other search
engines related reports.

Benefits

- Optimize the website for search engines

- See from what international versions of search engines your visitors come

Notes

- Click on the search site URL in the report to open it in your default browser

- This report includes both successful and error hits

10.5.7 Top Search Phrases Report

Top Search Phrases Report

This report shows a list of search phrases used by the visitors on different search  engines to find your
website. Report is ranked by the total number of referrals (Number of Hits column) generated  by each search
phrase. Click + sign or Expand button in toolbar to drill down into the search engines for each search phrase.
Second level shows the list search engines were this phrase was entered with the respective number of hits.

Deep Log Analyzer recognizes most of the modern search engines and their search phrases. If your website
gets hits from some local search sites that are not recognized by DLA, you can add them to Search Engine
Definitions. If you do that, referrals from them will also appear in this and other search engines related
reports.

Benefits

- Use right keywords when optimizing the website for search engines

- See what search phrases drive visitors to your site

- Find out if keywords, for which you optimized website, perform well on search engines

Notes

- Click on any record in expanded lower level of the report to see that part of information on the graphical
chart. Click on the upper level to switch graphical chart back to main view

- This report includes both successful and error hits
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10.5.8 Search Phrases History Report

Search Phrases History Report

This report illustrates how the total number of referrals generated by different search phrases on all search
engines changes over time. Click Expand All button in toolbar or + sign to view the daily history of hits for
individual search phrase. Upper level of the reports shows the total number of hits from each search phrase,
which is the same as in Top Search Phrases Report.

Deep Log Analyzer recognizes most of the modern search engines and their search phrases. If your website
gets hits from some local search sites that are not recognized by DLA, you can add them to Search Engine
Definitions. If you do that, referrals from them will also appear in this and other search engines related
reports.

Benefits

- Optimize the website for search engines

- Find out when your website's position in search engine result pages (SERP) has been changed for main
keywords

Notes

- Click on any record in expanded lower level of the report to see that part of information on the graphical
chart. Click on the upper level to switch graphical chart back to main view

- This report includes both successful and error hits

10.5.9 Spiders History Report

Spiders History Report

This report illustrates day-by-day history of search spiders visits. Upper level of the report shows the total
number of hits for each spider, which is the same as in Search Spiders Visits Report.

Click Expand All button in toolbar or + sign to view the daily history of hits for individual spider. Drill down to
the 3-d level to view the list of files requested by the spiders on each individual day.

Benefits

- See when search spiders visit your website

- Find out when search robots indexed your recently added web pages

Notes

- This report includes only search spiders recognized by Deep Log Analyzer. It can recognize more than 250
spiders. But you can make DLA to recognize even more crawlers by editing definitions file.

- Hits from spiders that are not recognized by DLA are shown in Unrecognized Browsers Report

- Deep Log Analyzer determines spider name by User Agent field in the log file

- This report includes both successful and error hits

10.5.10 Search Spiders Visits Report

Search Spiders Visits Report

This report shows the search engine spiders or "webcrawlers" that access your website ranked by number of
hits from each spider. Data Transferred column shows the amount of traffic in Kbytes transferred to each
spider. Click + sign or Expand button in toolbar to drill down into the web pages indexed by each spider with
the number of hits and data transferred for each page.

Benefits

- Find out if search spiders index all of your key web pages
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- See what robots visit your website

Notes

- This report includes only search spiders recognized by Deep Log Analyzer. It can recognize more than 250
spiders. But you can make DLA to recognize even more crawlers by editing definitions file.

- Hits from spiders that are not recognized by DLA are shown in Unrecognized Browsers Report

- Deep Log Analyzer determines spider name by User Agent field in the log file

- This report includes both successful and error hits

10.6 Visitors System Info

10.6.1 Browsers Report

Browsers Report

This report shows the web browsers used by visitors to access your site ranked by number of hits with each
browser. Data Transferred column shows the amount of traffic in Kbytes transferred to the visitors by each
web browser. Click + sign or Expand button in toolbar to drill down into the browsers versions and see the
number of hits and data transferred by browser versions.

Benefits

- Find out what browsers are used to view your website and optimize your website design for viewing in most
popular browsers

Notes

- This report includes only web browsers and download managers recognized by Deep Log Analyzer. You can
make DLA to recognize more specific browsers by editing browsers definitions.

- This report contains no hits from automated search spiders that are presented in a separate Search Spiders
Visits Report and no hits with the browsers DLA can not recognize listed in Unrecognized Browsers Report

- Deep Log Analyzer determines web browser name by User Agent field in the log file

- Correct browser can not be determined for some hits as not all records in the log file contain user agent field

- This report includes both successful and error hits

Requests for files from visitors. Each HTML document and graphic file counts as a separate hit, so hits are not
always an accurate representation of the number of different visitors to your site. Hits are also referred to as
requests.

10.6.2 Unrecognized Browsers Report

Unrecognized Browsers Report

This report shows user agents used by visitors to access your website that Deep Log Analyzer can not
recognize and identify as known browsers. Report is ranked by the number of hits with each user agent. Data
Transferred column shows the amount of traffic in Kbytes transferred to the visitors by each web browser.

If your website gets a significant number of hits from some unrecognized user agent you may want to add it to
browsers definitions. It will then move to Browsers Report.

Notes

- Deep Log Analyzer determines web browser name by User Agent field in the log file

- This report includes both successful and error hits
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10.6.3 Operating Systems Report

Operating Systems Report

This report shows the Operating Systems installed on visitors computers ranked by number of hits from each
OS. Data Transferred column shows the amount of traffic in Kbytes transferred to the visitors. Click + sign or
Expand button in toolbar to drill down into the browsers on the selected OS and see the number of hits and
data transferred by each browser.

Benefits

- Find out what operating systems are used by your website visitors

Notes

- This report includes only operating systems and web browsers recognized by Deep Log Analyzer. You can
make DLA to recognize more specific operating systems and browsers by editing definitions file.

- Deep Log Analyzer determines operating system and web browser name by User Agent field in the log file

- Correct OS and browser can not be determined for some hits as not all records in the log file contain user
agent field

- This report includes both successful and error hits

10.6.4 Screen Resolution Report

Screen Resolution Report

This report shows statistics on the screen resolution set on visitors's computers. Report is ranked by number
of visits with each resolution.

Benefits

- Find out what screen resolution are used to view your website and optimize your website design for viewing
in most popular resolutions

Notes

- This report requires DeepTracker Code installed on the website

10.6.5 Color Depth Report

Color Depth Report

This report shows statistics on the screen color depth set on visitors's computers. Report is ranked by number
of visits with each color depth. 32 bit color depth means highest color quality, 16 bits is medium color quality

Notes

- This report requires DeepTracker Code installed on the website.

10.6.6 JavaScript Support Report

JavaScript Support Report

This report how many visitors have JavaScript support enabled in their browsers. Second level of the report
shows web browser names with enabled and disabled javascript support

Notes

- This report requires DeepTracker Code installed on the website



Deep Log Analyzer74

© 2006 Deep Software Inc.

10.6.7 Flash plugin/addon Versions Report

Flash plugin/addon Versions Report

This report shows statistics on the Flash plugin /addon installed in the browsers of website visitors. Second
level shows names of the web browsers with particular Flash version. The report is ranked by the number of
visits with each version of Flash.

Benefits

- Check if most visitors have Flash version that supports particular features that you might use in the Flash
files used in your web site's design

Notes

- This report requires DeepTracker Code installed on the website

10.6.8 System Language Report

System Language Report

This report shows statistics on the visitors' browser language. The language is set in Firefox browser in
Options->Advanced->Language and in IE in  Internet Options->General->Language.
Second level of the report shows countries of visitors with particular system language. Country is determined
form IP address using IP-To-Country database. 
This gives you an interesting information about in which countries the language is used. For example, you can
see that French (fr) used (in top to bottom order) in France, Canada, Belgium, Switzerland

Notes

- This report requires DeepTracker Code installed on the website

10.7 Diagnostic

10.7.1 Server Errors Report

Server Errors Report

This report shows the different errors occurring on your website. Click + sign or Expand button in toolbar to
view the referrers list that led visitor to the website page resulting in error.

Status Code Definitions:
http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html#sec10

IIS Status Codes:
http://support.microsoft.com/default.aspx?scid=kb;en-us;318380

Benefits

- Use the information in this report to diagnose and fix errors. A large number of errors can decrease your
website's usability and reputation.

10.7.2 Page Not Found Errors Report

Page Not Found Errors Report

This report shows the files that caused Page Not Found (404) errors on your website. Click + sign or Expand
button in toolbar to view the referrers list that possibly contain broken link to the web pages on your site. This
is often happens when a page is renamed or deleted from your website.

Status Code Definitions:
http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html#sec10

http://www.w3.org/protocols/rfc2616/rfc2616-sec10.html#sec10
http://support.microsoft.com/default.aspx?scid=kb;en-us;318380
http://www.w3.org/protocols/rfc2616/rfc2616-sec10.html#sec10
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IIS Status Codes:
http://support.microsoft.com/default.aspx?scid=kb;en-us;318380

Benefits

- Use the information in this report to eliminate broken links

 

10.7.3 Incomplete Downloads/Requests Report

Incomplete Downloads/Requests Report

This report shows Partial Content (status code 206) errors occurring on your website. This error means that
requested file was not fully transferred to the visitor.  This often happens when users cancel download of large
files or become disconnected during download.

Status Code Definitions:
http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html#sec10

IIS Status Codes:
http://support.microsoft.com/default.aspx?scid=kb;en-us;318380

Notes

- Visitors may use special downloader programs that download large files by parts causing multiple requests to
the file recorded in log. All such requests appear in log file as incomplete downloads.

http://support.microsoft.com/default.aspx?scid=kb;en-us;318380
http://www.w3.org/protocols/rfc2616/rfc2616-sec10.html#sec10
http://support.microsoft.com/default.aspx?scid=kb;en-us;318380
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